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Course overview

Course description

The Introduction to Teamcenter course introduces the concept of collaborative
product data management (cPDM), working in a collaborative environment
to share product data. You will become familiar with the rich client user
interface and learn the basics of using the Teamcenter software.

Course objectives

To become familiar with the rich client user interface and learn the basics
of using the Teamcenter software.

¢ To understand the concept of collaborative product data management
(cPDM).

e To become familiar with the rich client and thin client user interfaces.
¢ To use the rich client user interface to perform basic user tasks.

e To use various navigation methods to locate, view, and report on product
data.

¢ To create Teamcenter items and populate the items with master data.

e To learn how data is secured and access is controlled in a collaborative
data management environment.
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Key benefits

Key benefits

Key benefits for completing the course objectives include:

e Using a collaborative product data management (cPDM) system to find,
view, and create data.

e Using the rich client interface to perform basic user tasks and organize
product data.

¢ Configuring the navigation pane for efficient access to frequently used
product data and functions.

¢ (Creating data items, populating the items with master data, and
configuring the data display.

e Working with secure data in a collaborative product data management
environment.

Prerequisites

¢ Familiarity with basic Windows operating system commands.
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Course overview

Audience

The primary audience for this course is the consumer.

The potential audience for this course includes:

User profile Job goal
Consumer Gather information.
Reviewer Provide feedback.
Administer product structure, create data,
Author

and relate objects.

Install, upgrade, migrate, and configure
software

Administer users, configure security, define
workflow handlers, and define dataset types.

Installer

Application Administrator

Learning tracks

Learning tracks for the Teamcenter application are found on the Siemens
PLM Software training website: http://training.ugs.com/tracks/index.shtml

Recommended Courses

e MT25450 — Teamcenter Data Model Administration

e MT25350 — Teamcenter Installation
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Training materials provided

Training materials provided

Material Description

Presentation slides.
Yours to keep and make notes.

Student Guide Evaluation is provided both online and in the
appendix.

Student profile is provided in the appendix.

Activities are provided online in electronic format

and designed to appear on the left of the monitor.
Student Workbook
A CD of electronic activities is provided in the back

of the Student Guide.
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Course overview

Introduction to Help

Throughout this class, you access Help topics to learn more about the product.
The Help Library covers functionality from end-user tasks to customization
instructions.

There are several ways to access help from Teamcenter.

e To access the Help Library, click the Help button or choose Help from
the main menu.

e Press F1.
— Current application help for the rich client
Note

You cannot access application-specific help in the Thin Client.

— Context-sensitive help for the Business Modeler IDE

¢ Press F2.
— Help library for the rich client
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Lesson

Introduction to Teamcenter

Purpose

The purpose of this lesson is to introduce the students to the Teamcenter
software applications and product data management concepts.

Objectives
After you complete this lesson, you should be familiar with:

¢ Basic concepts of collaborative product data management.

e An overview of commonly used Teamcenter applications software
packages.

e The Teamcenter rich client and Teamcenter thin client interface usage.

Help topics
Additional information for this lesson can be found in:

e  @Getting Started with Teamcenter 2007

Introduction to Teamcenter
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Introduction to Teamcenter

Basic concepts

1-2

Teamcenter is a suite of digital product lifecycle management solutions

built on an open PLM foundation that integrates idea management and
requirements planning into the digital lifecycle management, product
development, and manufacturing process. Teamcenter links OEMs, partners,
and suppliers with secure, global access to your product knowledge, and
enables consistent, repeatable processes and commonality. Data is stored in a
shared repository and is accessible to everyone based on access rules.

Teamcenter supports all phases of the product lifecycle, including:

Requirements management

Product structure and configuration management
Classification and reuse

Product visualization

Repeatable Digital Validation

Change management

Multi-Site Collaboration

Manufacturing process management
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Introduction to Teamcenter

What is collaborative product data management?

Teamcenter is a collaborative product data management (cPDM) system.
cPDM is a tool that helps manage all the processes, applications, and
information required to design, manufacture, and support a product
throughout its life cycle.

The goal of a cPDM system is to provide a single, common interface for
managing and accessing all data within an organization.

cPDM systems interface with enterprise resource planning (ERP) systems.
With ¢cPDM, ERP systems and the Web interface, you have all the ingredients
for a true collaborative environment.
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Introduction to Teamcenter

1-4

Benefits of cPDM

Benefits of using the Teamcenter cPDM system include:

Reduces duplicate data which reduces storage requirements.
Simplifies finding data and distributing data to those who need it.

Allows quick, lightweight viewing of models. This is especially useful for
verification when reviewing changes.

Provides revision control and assurance of latest data.
Manages assemblies and relationships between parts.
Easily builds and modifies bills of materials (BOMs).
Maintains history of a product’s development evolution.

Establishes relationships between parts including requirements and
specifications.

Provides access control and vaulting to assure integrity of data.
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Introduction to Teamcenter

Teamcenter applications

Some of the most commonly used Teamcenter software applications include
My Teamcenter, Product Structure Editor (PSE), Teamcenter for lifecycle
visualization embedded viewer, Workflow Viewer, and Change Management.

My Teamcenter is the workspace you use to manage your product
information. My Teamcenter serves as the main access point for many
commonly used functions, such as object creation, checkin/checkout, task
management, and query execution.

Note

Much of the basic functionality present in My Teamcenter is
available in many of the Teamcenter applications.

Use PSE to create, view, and modify product structures. PSE also manages
product structures that were created in an MCAD program such as NX®,

PSE allows creation of generic bills of materials which show different
configurations of components.

The visualization tools available in Teamcenter, both the embedded
viewer and stand-alone Teamcenter for lifecycle visualization, enable even
nontechnical users to interpret design data, review product structure, and
mark up issues for collaboration.

Workflow Viewer presents a dynamic user interface to view the progress
of a workflow process for an object, whether it is currently in process or
has already achieved its final status.

Change Management enables functionality to initiate, administer, review,
approve, and execute product changes. By automating the change process,
Change Management can minimize change-related rework and coordinate
tasks to be performed by individuals across your organization.
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Introduction to Teamcenter

Teamcenter user interfaces

1-6

Teamcenter user interfaces include the rich client interface and the thin
client interface.

The rich client interface is used by authors who are responsible for the
design and configuration of product data, manufacturing authors who
are responsible for creating and maintaining processes and process
structures, administrators responsible for configuring and maintaining
Teamcenter, and other users who require extensive authoring access to
data stored in the Teamcenter database.

The lightweight thin client interface is used by consumers, manufacturing
consumers, and reviewers who need to view data, including product
structure and variant information, approve data attached to a workflow
task, or visualize 2D drawings and 3D models. The thin client interface is
ideal for suppliers, production staff, and other users who do not require
extensive authoring or administrative access to Teamcenter.
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Introduction to Teamcenter

Rich client interface

The Teamcenter rich client is a Java application that runs on client hosts that
serves as a gateway to your company’s product information. You can integrate
and run Teamcenter’s product data management applications along with
other applications, such as Microsoft Office applications, custom applications,
Java Plug-ins, or CAD/CAM/CAE applications, all from a common platform.
The rich client accesses Teamcenter databases using a remote or local server.

9Getting Started - Teamcenter 2007
File ‘Window Help 1

IR 2

Getting Started

IEnter Item ID to Search —a—"—

Customize &

& Home 6 »

B My Warklist %
o4 My Saved Searches »
&5 My Links »
rFs
rFs

.y mill_planar_target_metric

Organize &

9

Cuslolqig -

i} Getting Started

@ My Teamcenter

ER e e N s

N TeaMCENTER

[=] B3

@ Teamcenter 2007

‘Welcome to Teamcenter 2007 - Opening your world to shared data and communication within your organization.
To begin, you can:

- Enter a part number in the box below to begin your work
- Click on an application in the navigation bar on the left

- Click on a hyperlink below

We hope wou enjoy your experience with Teamcenter, We look forward to serving your data management needs,

Find a part and begin my work:  [Enter [tem D to Search -

Open my workspace, or Inbox

Wiew or edit a product structure

Wiew or edit my company's claszification data 1 4

16

2

Ready

15

Figure 1-1. Teamcenter rich client window
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Table 1-1. The Teamcenter rich client window description

Number

Description

1

10

11

12

13

14

Introduction to Teamcenter

The menu bar contains menus for the application that is currently
displayed.
The toolbar provides access to commonly used menu options.

When you point to a button, a tool tip appears. The buttons
available on the toolbar varies between applications.

The Back and Forward buttons allow you to move between open
Teamcenter applications.

Quick Search provides predefined searches using dataset, item
ID, item name, keyword search, and advanced search features.

The navigation pane provides quick access to the data you use
most. In addition to finding, organizing, and accessing your data,
you can configure the display of the Teamcenter application icons
in the navigation pane to display only those applications that you
use regularly to perform your tasks.

Quick links provide access to your Home folder, work list, saved
searches, and web links.

Open items displays links to items that are open in the active
application.

History displays links to Teamcenter applications or objects that
you opened. Links are displayed in reverse order; the last object
you opened is the first displayed in the History list.

Favorites displays links to Teamcenter objects that you have
designated as favorites.

| Want To provides links to the tools used to complete tasks that
you perform repeatedly, such as initiating a process or change.

Primary application buttons provide access to your most
frequently used Teamcenter applications.

Secondary application buttons provide access to the Teamcenter
applications that you use infrequently.

The Configure Applications button provides access to the tools
you can use to configure the display of primary and secondary
applications.

The application pane displays the applications that are open in
your Teamcenter session.

MT25100-S-0701
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Table 1-1. The Teamcenter rich client window description

Number Description

15 The system displays information about selected objects in the
Information Center.

Information Center symbols convey where-used and
where-referenced, access privilege, child count, and status
information about the selected object. To display the information,
point to the symbol. The information displays in the form of a
tool tip.

16 The clipboard contains references to objects that have been cut
or copied from your workspace. The number of objects on the
clipboard is displayed to the right of the icon.

17 Application tabs provide access to your open applications.
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Thin client interface

Teamcenter thin client provides an access point to your data over the Web
using a Web browser configured to use the Sun Java runtime environment.
Thin client access is available to the same Teamcenter server and data as the
rich client uses; no thin client software is required on a Teamcenter client.

i —

Quick Search

Group ID | Date Modified 00 Release Status |

EMI0 D0 10 10 Se3rch

E

&

E S amox Mall Foider
H=r ; |

-
Quick Links Hewstutt | evedull Foble:

Beome 4 »
ﬂmy Worklgt »
iy seves searenes

% wiy Links

Histary 5
&eome ____2

View Al #

Faverites ﬁ Organize Q
View Al ¥

I'Want To Chstomire
PAcreare annen
Bt 4 Deflest

B create aprocess .

=
@'y resmcerter

=]
E‘ Product Structure Eciior

Clazsification

‘ * DesignContest

Figure 1-2. Teamcenter thin client window

Table 1-2. Teamcenter thin client window

Number Description

1 Application tabs provide access to your open applications.

2 The navigation pane provides quick access to the data you use
most. You can use it find, organize, and access your data.

3 Quick Search provides predefined searches that enable you to
locate your data by dataset, item ID, item name, or keyword.

4 Quick links provide access to your Home folder, work list, saved
searches, and web links.

5 History displays links to Teamcenter applications or objects that
you opened. Links are displayed in reverse order; the last object
you opened is the first displayed in the History list.

6 Favorites displays links to Teamcenter objects that you have
designated as favorites.
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Table 1-2. Teamcenter thin client window

Number Description

7 | Want To provides links to the tools used to complete tasks that
you perform repeatedly, such as initiating a process or change.

Note

The | Want To section may not be displayed in the navigation
pane when the Quick Links, Open Items, History, and
Favorites lists are expanded. In addition, the | Want

To section may not be displayed if you choose to display
multiple primary applications.

To display the | Want To section, collapse the Quick Links,
Open Items, History, and Favorites lists or display fewer
primary applications by

8 Primary application buttons provide access to your most
frequently used Teamcenter applications.

9 The application pane displays the applications that are open
in your Teamcenter session. Tabs enable you to move between
applications to perform your tasks.

10 The menu bar contains menus for the application that is currently
displayed.
11 Ends your thin client session.
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Summary

Topics learned in this lesson:

1. Basic concepts of collaborative product data management.
2. An overview of some commonly used Teamcenter software applications.

3. The basic differences between the rich client and thin client interfaces
and in what circumstances each is used.
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Lesson

Getting started with Teamcenter

Purpose

The purpose of this lesson is to learn how to start the software, launch an
application, and navigate the help system.

Objectives

After you complete this lesson, you should be able to:

e Start a Teamcenter software session.

e Use the Getting Started application.

e Configure the navigation pane.

e Start My Teamcenter and navigate the user interface.
¢ Organize data in folders.

¢ Use Teamcenter mail.

e Access online help and find the information you need.
Help topics

Additional information for this lesson can be found in:

e QGetting Started with Teamcenter 2007

e My Teamcenter Guide
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Getting started with Teamcenter

Teamcenter software startup

The procedures for starting Teamcenter differs depending on if you want to
run a rich client or a thin client session.
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Getting started with Teamcenter

Start a Teamcenter rich client session

¢ (Choose Start—All Programs—Siemens PLM Software Teamcenter
2007—Teamcenter 2007 or double-click the & icon on your desktop.

Tip
If you do not have a Teamcenter shortcut:

1. Choose Start—All Programs—Siemens PLM Software Teamcenter
2007—Teamcenter 2007, and right-click Teamcenter PLM.

2. Choose Send To—Desktop.
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Getting started with Teamcenter

Start a Teamcenter thin client session

1. Open the Web browser and type the URL of the Web server in the Address
box in the following format:

http://machine name:port number/application name/webclient

machine_name is the network name of the system on which the Web
server is running, port_number is the port on which it is configured to
listen for requests, and application_name is the deployed application
name (default is te). For example:

http://engservell.ugs.com:7001/tc/webclient
or

http://engservell.ugs.com:7001/appl/webclient

2. Click Go.

The Teamcenter logon page is displayed in your browser.

3. Type your Teamcenter user name and password and click OK.

Teamcenter appears in your browser. You are automatically logged on
using your default group and role.

Tip

You can change your group or role by clicking the User Settings link in
the navigation pane.
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Getting started with Teamcenter

Getting Started application

The Getting Started application is launched at initial start up of a Teamcenter
rich client session.

There are various methods you can use to log on and begin your work from
the Getting Started application using the navigation pane or the Getting
Started pane.
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Getting started with Teamcenter

Getting Started pane

B2 Getting Started X i

EJ Teamcenter 2007

‘Welcome to Teamcenter 2007 - Opening your swarld to shared data and communication sithin your organization.
To begin, wou can:

- Enter a part number in the box below to begin your work
- Click on an application in the nawigation bar on the left

- Click on a hyperlink belosa

We hope you enjoy your experience with Teamcenter, We look forward to serving your data management needs,

Find a part and begin my work: | h

Ea;; Open my workspace, or Inbox

Pl “Wiess or edit a product structure

From the Getting Started pane, you can:

e Use the Find a part and begin my work box to log on and execute a search
on the part you want to work on and launch the applicable software
application.

¢ (Click Open my workspace, or Inbox to log on and immediately access
your workspace or inbox.

e C(lick any other application link listed on your Getting Started navigation
pane to log on and immediately access the applicable application data.

Note

The application links listed depend on which Teamcenter
applications are installed at your site.
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Getting started with Teamcenter

Navigation pane

| a-
Quick Links e
&® Home X
&y My Worklist b5t

7y My Saved Searches
& My Links b5t
Open Rems e
Y Getting Started

'iﬁl My Teamcenter
E Schedule Manager
4+ DesignContext

= CH Viewer

From the navigation pane, you can:

e Execute a search on the part you want to work on to log on and launch
the applicable software application.

e (lick a quick link to log on and go to the specified location or function.
e (lick an application button to log on and launch the desired application.

e (lick Configure Application to add, remove, and organize the application
startup buttons on the navigation pane.
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Getting started with Teamcenter

Configuring the navigation pane
The navigation pane provides quick access to the data you use most. You can

use it to find and organize and your data and to perform common tasks, such
as creating parts and datasets or releasing a part.

You can configure the navigation pane as follows:

¢ Add, remove, organize, and rename quick link containers.
¢ Add, remove, organize, and rename your saved searches.

¢ Add, remove, organize, and rename links to your most frequently used
data.

¢ Add, remove, and organize tasks in your | Want To list.
e Show or hide the navigation pane.

How to configure the navigation pane will be taught, as applicable,
throughout the course.
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Getting started with Teamcenter

My Teamcenter application startup

To start My Teamcenter, click *#* My Teamcenter in the navigation pane.

If you do not see My Teamcenter listed by name as a primary application,
check for the My Teamcenter button in the secondary application buttons
at the bottom of the navigation pane. You can use Configure Applications
at the bottom of the navigation pane to find and place the My Teamcenter
application button in the navigation pane.
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Getting started with Teamcenter

My Teamcenter user interface

2-10

Many of the main components of the My Teamcenter user interface are
common to other Teamcenter applications.

Some menu commands and toolbar buttons are specific to My Teamcenter.

The My Teamcenter commands available at your site may differ based on
site-specific configuration and customization.

Menu commands

Following is a general description of the My Teamcenter menu commands:

Use the File menu commands to create and manage your data objects,
close an application, and exit the rich client.

Use the Edit menu commands to perform basic editing tasks on selected
objects, view and/or change user settings and preferences, and to move
selected objects around the tree structure.

Note

You must have read and write privileges to the objects you want to
cut, copy, or paste.

Use the View menu commands to perform various tasks related to
displaying Teamcenter data.

Use the Tools menu commands to perform actions on objects, such as
checking them in and out, and to create and manage address lists and
generate reports.

Use the Window menu commands to open a new application window and
customize your desktop.

Use the Help menu commands to access online help for the Teamcenter
software applications, and view information about the installed software
product.

Toolbar buttons

The My Teamcenter toolbar buttons provide easy access to frequently used
navigation and editing tasks.

You can customize the toolbar for access to the tasks you use most often.
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Basic My Teamcenter tasks

You can use My Teamcenter to perform the following tasks:

e (Create folders to organize commonly referenced objects and relationships.

e View the contents of your Home folder, My Worklist, My Saved Searches,
and My Links.

¢ Perform and track tasks.
e Send and receive mail.
¢ Open objects, automatically launching the related Teamcenter application.

e Search for objects, both in your local environment and at remote sites,
using predefined queries.

¢ Compare search results to other searches or collections.

¢ (Create and manage items, item revisions, and datasets.
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Organize data in folders

My Teamcenter displays product information as various graphical objects.

Each user has a unique personal My Teamcenter window. Therefore, although
you may share product information across the enterprise with other users,
you can always organize this information in the way that best meets your
individual needs.

Folders can be used to organize Teamcenter data. Folder objects can contain
references to other objects and/or other folders.

What are folders?

e Folders can be used as a tool to organize both company-wide and
individual user data.

¢ Your company may create a visual method of organizing data using folders.
e Data can be referenced by any number of folders.

¢ Folders can be nested to practically any extent desired.

¢ A folder in Teamcenter is not the same as a directory in the operating

system. When you delete a folder in Teamcenter, only the folder is deleted,
not the contents of the folder.
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Working with folders

Folders are a flexible way to organize your product information. Folder objects
can contain references to other objects and/or other folders.

Use Teamcenter to:

e C(Create a new folder.
¢ Rename a folder.

e Move a folder.

e Print a folder.

e Delete a folder.
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Create a new folder

¢ (Choose File®New®Folder to create a new folder.

2 New Folder @

[E::
Marne: *
I-i Description:
Falder
Mail Folder

[~

Messtuff Fal, .,

[ ] Open On Create

Key points

Key points about the New Folder dialog box:

e A red asterisk indicates a required entry.
e Enter a short descriptive name. The limit is 32 ASCII characters.

* You can enter a general text description of up to 240 characters. This
is optional.

e Set the Type to Folder for general-purpose folders.
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Rename a folder

¢ To change the name of a folder, right-click the folder object and choose
Properties

The Properties dialog box for the selected folder object appears.

3P Properties

W Folder

Mame: My Folder

Description:

Type:

Ownert 8 Hope, Roberta (rhope) ™
Group 10t 8y body
Last Modifying User: & Hope, Roberta (rhope)

< | >

[ Check-COut and Edit ] [ Zancel ]

zenaral | Rezerration | FProject | All

In the Properties dialog box, you can enter a new name and/or description for
the folder, if desired.

Note

You may need to scroll down or click More to access the Name and/or
Description boxes to edit.
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Move a folder

You can reorder the folders in your Home folder structure by moving them
up or down.

e Select a folder object and choose Edit®Move®Up to move a folder up
(closer to the top-level folder) in the My Teamcenter object area.

e Conversely, select a folder object and choose Edit®Move®Down to move
a folder down in the My Teamcenter object area.
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Print a folder

e Select the folder and choose File®Print or File®Print....

Choose File®Print to print the folder name and a listing of the folder contents.

[IHTML  [#] Text

Corterts of My Partz(1 level )

My Parts
S100_000-Caster Azay
S000_000-Caster Azsy
5003 _000-Shatt
S004_000-Spacer
5555 _000-wheel

4 | 11T ] >

Close

Choose File®Print... to access additional print options.

7 Print... My Parts

@ Ohject Propetties

() Contents Level |1

() &pplication (HTRMLTe:xt)

O Application (Graphics)

[ (8] J [ Cancel J
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218

Delete a folder

1. Select the folder object and click Delete X .

A confirmation dialog appears so you can confirm the deletion.

More. ..

Ok to Delete? (¥]
[ ]
Less...

= My Part= D

[ YEs J[ flo ]

3. Click Yes if you want to delete the folder.
Note

When deleting a folder, the contents of the folder are not deleted.
The folder contents remain in the database and can be located and
retrieved using the search feature in My Teamcenter.
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Home, Newstuff, and Mailbox folders

The My Teamcenter application always contains the three default folders:
Home, Mailbox, and Newstuff. These folders are automatically created by
the system.

’.\_ﬂ Horne
A

+ [ My Parts
+ 8 Mailbo
+ B Mewstuff

Home folder

The objects you want to work with in the My Teamcenter application can be
placed within your Home folder or within some folder structure beneath
the Home folder.

Mailbox folder

The Mailbox folder is the receiving point for any Teamcenter mail that
has been sent to you. When you receive new Teamcenter mail, you see an
envelope object in your Mailbox folder.

Newstuff folder

The Newstuff folder is the default folder for newly created database objects.
You can designate other folders as the default location for newly created
database objects.
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Sending and receiving Teamcenter mail

Teamcenter mail enables you to send mail from within the Teamcenter
interface, including attachments, to other Teamcenter users. In addition,
you can send mail from Teamcenter to people who are not Teamcenter users
by specifying a valid SMTP address.
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Send a mail message

1. (Optional) Select attachments from the navigation tree.
Tip
You can also copy attachments to the clipboard and insert them
in the Attachments box.

2. Choose File—New—Envelope.

3. Use one of the following methods to enter the addresses in the To box:

e Type the addresses of the users, groups, address lists, or external
recipients in the To and/or CC boxes.

Note

To send external mail, you must specify a valid SMTP address.

e Search for recipients by performing the following steps:
a. Click the To button.
b. Type search criteria in the Search box to search by user ID, group,
or address list.

Note
Entering the wildcard character in this box displays the

entire recipient list.

c. Click one of the following buttons to execute the search: User 8 ,
Groups “ , or Address List = .

d. Select the users, groups, or address lists that you want to receive
the message, and click the To or CC buttons.
Tip
You can remove recipients from the lists by selecting the user
and clicking the Remove button (-). In addition, you can
create a new address list by clicking the Launch Address

List button ® and following the instructions described in
Create an address list.

e. Click OK.

4. In the New Envelope dialog box, type the subject of the message in the
Subject box.

5. Type your message in the Message box.
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6. (Optional) Click the Add button + to the right of the Attachments section
to copy items from the clipboard as attachments.

7. Click Send to send the message.
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Receive and read mail

An envelope is delivered to the mailbox of each user whose name appears in
the TO or CC list of sent mail.

To read your mail, open your Mailbox folder and click the envelope to display
the contents in the Details pane.
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Using address lists

Address lists can contain any combination of valid Teamcenter users and
groups. In addition, external email addresses and other Teamcenter address
lists can be used as entries in address lists.

In addition to the procedure described below, you can create address lists
when selecting mail recipients by clicking the Launch Address List button
located beneath the Search pane in the Select Recipients dialog box.

:ﬂ’Select Recipients x|

Search: |*| Ll _ﬂl

&
il
=

=
Ii W

e =5

Jd

[Launch Addresss List Dislog. |
I _OTTCET I
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Create an address list

1. Choose Tools—Address List.

2. Type the name of the address list in the text box under the Address List
pane, and click the Add button + .

3. Type the names of the members or select the members, users and/or
groups, that you want to add to the address list. The members that you
add to the address list display in the Member(s) pane.

4. Click Close.
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Viewing online help

2-26

Teamcenter provides help for each application, as well as a series of getting
started guides.

Access help for the current application

¢ In the rich client, choose Help®Help®Current Application or press the
F1 key.

Note

You cannot access application-specific help in the thin client.

Access the help library
e In the rich client, choose Help®Help®Help Library or press the F2 key.

¢ In the thin client, choose Help®Web Collection to access thin client help
or choose Help®General Collection to access the full library.

Access information about the application

¢ In the rich client, choose Help®About.

The system displays information about the application, including
information about plug-ins and configuration details.

¢ In the thin client, choose Help®About.
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Navigating the help system

The following figure shows the Teamcenter help system navigation buttons.

1 2 3 4
5 6 7 8 8
EQ i o 1 12 ? 14 g '
o
E] Getting Started with Product Structure Tea mcenter 2007
@ Product Structure Overview

Basic principles

Configuration Getting Sta rted With

Architecture

T Product Structure

The following table describes how each button can be used to navigate the
help system.

Table 2-1. Teamcenter help system usage

Component Purpose
1 Displays the table of contents.
2 Launches the search tool. You can use this

tool to search for information within the
application help or within the entire help

collection.

3 Lists bookmarks to help topics that you
reference frequently.

4 Displays the index for the help module.

5 Provides information about using the help

system, including tips on using Search to
find the information you need.

6 Takes you to the main index page for the
help collection.

7 Enables you to create a bookmark to the
topic displayed in your browser window.

8 Moves to the previous topic, as shown in the
table of contents.

9 Moves to the next topic, as shown in the
table of contents.

10 Expands the table of contents.

11 Collapses the table of contents.

12 Hides the table of contents.
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Using Help on Help

In the online help, you can click the Help button ) t0 access Help on Help.

You can navigate Help on Help to find information such as tips on using the
Search function to find the information you need.

Search tips include using the wild card characters * and ¢ in the search string.

‘A Help on Help - Microsoft Internet Explorer

i
Qs BRI
Eliee e Searching the Entire Library
Help on Help
[:Q| Using the Help Library 1
Basic Navigstion To search online docurentation from the Hegp Ldrary page:
Mare on Search
SEarching the Ertire Library 1. Click the Search icon.
Finding Itens Within an Open Document You can: B

o Select the format of the results using the Format
field.

o Limit the number of hits using the Maximum results

field.

o Indicate whether or not to highlight search text
occurrences using the Highlight keywords

chieckbox,

2. Enter the text to search for {click the Search Tips link

for more information). |
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Activities

Complete the following activities to reinforce the material taught in this
lesson.
1. Start Teamcenter and configure the navigation pane.
2. Log on to My Teamcenter.
In this activity, you log on to My Teamcenter and explore the user
interface.
3. Create and rename a folder.
In this activity, you create a folder to organize your data.
4. Send and receive Teamcenter mail.
In this activity, you practice sending and receiving Teamcenter mail.
5. Navigate the Teamcenter 2007 Help Library.

In this activity, you access and navigate the Getting Started with
Teamcenter 2007 online help and search for a help topic.

Review questions

1.

The procedures for starting Teamcenter differs depending on if you want
to run a rich client or a thin client session

Select all that apply.

e True
e TFalse

What is the initial start application of Teamcenter?

Select one answer.

e Getting Started
e My Teamcenter
e My Worklist

¢ Organization
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2-30

3. You can configure the navigation pane as follows:

Select all that apply.

¢ Add, remove, and organize links to your most frequently used
applications.

¢ Add, remove, organize, and rename quick link containers and data.
e Add, remove, organize, and rename users.
¢ Add, remove, organize, and rename your saved searches.

4. What is the primary working application of Teamcenter?

Select one answer.

¢ Getting Started
e My Teamcenter
e My Worklist
¢ Organization

5. What folder is the default folder for newly created database objects?

Select one answer.

e Home folder
e Mail folder
e New folder

e Newstuff folder

6. Address lists can contain any combination of valid Teamcenter users and

groups.
e True
e TFalse

7. Which function key opens the help library in the rich client?
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Summary

Topics learned in this lesson:

1. Start the Teamcenter software.

2. Use the Getting Started application.

3. Configure the navigation pane.

4. Start the My Teamcenter application.

5. Navigate the My Teamcenter user interface.
6. Organize data in folders.

7. Use Teamcenter mail.

8. Access online help and find the information you need.
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Lesson

Working in Teamcenter

Purpose

The purpose of this lesson is to learn the basics of working in Teamcenter
using the rich client interface and the My Teamcenter application.

Objectives

After you complete this lesson, you will be able to:

Identify items and the item structure.

Create an item and populate it with master data.
Use checkout to create an item revision sequence.
Identify datasets and dataset types.

Create a dataset and work with versions.

Create an object reference.

Create new data from existing data.

Help topics

Additional information for this lesson can be found in:

Getting Started with Teamcenter 2007

My Teamcenter Guide
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Items and item revisions

3-2

Items and item revisions are the fundamental data objects used to manage
information in Teamcenter.

e Items are structures that are generally used to represent a product, part,
or component. Items can contain other data objects including other items
and folders.

e Item revisions are data objects used to manage revisions to items.

e Each item revision has one or more associated sequence IDs. Checkout

actions increment the sequence ID for the item revision, with the most
recent sequence ID becoming the default.

Key points

¢ An item can be thought of as a "package" which contains all data related
to that item.

e Each item has at least one item revision.
e Each item revision has at lease one sequence ID.

e TJtems store all revisions of the item.

Introduction to Teamcenter MT25100-S-0701



Working in Teamcenter

Basic item structure

An item in Teamcenter is a structure of related objects. The basic structure of
any item consists of the following minimum objects:

7 Item
= Item Master (Form)
“ ItemRevision

= ItemRevision Master (Form)

Key points

e [tem

Collects data that is globally applicable to all revisions of the item.

¢ |tem Master (Form)

A form object that is often used to extend the stored property data for an
item to include data unique to the customer.

e |temRevision

Collects data that is applicable to a single revision of the item.

¢ ItemRevision Master (Form)

A form object that is often used to extend the stored property data for an
item revision to include data unique to the customer.
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Item types

The term item is used to generically describe all ¢ypes of items that exist in
the system.

The system comes with several generic item types including:
e Item

e Document

¢ EngChange
Note

Many customers define additional item types in their system. This
allows for more specific categorization of data beyond the types
described above.
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Creating items

The New Item dialog box provides a wizard-like tool for creating items,
entering item and item revision attribute information, creating alternate
identifiers for the item, assigning the item to a project, and defining options
for displaying the item and alternate identifiers.

Mandatory steps required to create a new item are indicated by a red
asterisk. Once the mandatory steps are performed, you can then continue
through the remaining steps in order, select individual steps from the list, or
exit the wizard. It is not necessary to work through the steps sequentially,
nor is it necessary to complete all of the steps. If mandatory item master

or item revision master attributes are defined for the item business object,
values must be entered before the system can create the item.
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Create an item

1.

2.

Select a container for the item, such as a folder or another item.

Choose File—New—ltem or press Ctrl+T.

The system displays the New Item dialog box.

Select the item type that you want to create.

Note

The item types displayed in this dialog box are controlled by your
administrator. It is possible that you may be unable to create item
types that are visible to you in your workspace.

Optionally, select the Configuration Item check box. Configuration items
define the point in a product structure where the effectivity context
changes.

Click Next.
The system displays the item information pane.

Note

The Name and Description fields may contain initial values
determined by property rules implemented at your site. You can
replace such values, but you cannot specify a null value by clearing
the field. If you clear the field, the initial value will be reapplied to
the property when you save the new item.

Enter an item ID, revision, and name for the item, or click Assign to
automatically generate the item ID and revision identifiers. The Assign
button is active only if naming rules and automatic generation have been
implemented for the selected object type.

Tip

It may be necessary to resize the dialog box to view the Assign
button.

Optionally, enter a description of the item and select a unit of measure.

At this point, you have provided all of the information necessary to define
the item.

To define the item and proceed to another step, click Next.
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Note

The item is not created until you click Finish. If mandatory item
master or item revision master attributes are defined for the item
type, the attribute values must be supplied before you create the

item.
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Populate an item with data

After an item is created, the next step may be filling out forms to add data
to the item.

Add master data

Every time a new item is created, an Item Master form object is created
automatically. When a new item revision object is created, an ltemRevision
Master form object is created automatically.

You can enter data in the item master and item revision master forms when
you create an item or by opening the ItemMaster or ltemRevision Master
form object after it has been created.
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Creating item revisions

The initial item revision associated with an item is automatically created
when the item is created.

To create subsequent revisions for the item, select an existing item revision
and choose File®Revise.

¢ (Creating a new revision copies the objects and object references related to
the existing item revision to the new revision.

e The related objects can be copied as references, new objects, or not at all.
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Item revision sequences

When an item revision is created, an initial sequence and sequence ID is also
created. This sequence ID becomes the active, or default, sequence.

The integrity of Teamcenter data is protected by checkin/checkout features
used to lock other users out of work that is in process, allowing them to view
but not modify the information. The sequence ID increments or decrements
based on the checkin and checkout operations performed on an item revision.

e When an item revision is checked out for modification, the sequence ID
increments and the most recent sequence ID becomes the default.

e (Canceling a checkout decrements the sequence ID and discards any
changes that have been saved to the database.

¢ Only one sequence can be active at any given time for an item revision.
e The number of sequences stored in the database for an item revision is

limited to the number set by your site administrator. When the limit is
reached, the system automatically removes the oldest sequence at checkin.
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Sequence ID display

Teamcenter displays the sequence ID appended to the item ID and revision,
separated from the item revision by a semicolon (;). The sequence ID is
followed by a hyphen (-) and the object name. For example, the third checkin
for item revision 3540/A of part Bumper is displayed as follows:

3540/A;3-Bumper

¢ By default, the system displays only the active sequence.

e All sequences for an item revision can be found and displayed using
a search query.
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Managing revision sequences

e When you create a new item revision, such as from revision A to revision
B, the new revision starts with the first sequence ID.

¢  You can set immunity for sequences to prevent their automatic removal.

e To add a new sequence after you reach the limit, you must remove at least
one sequence by using either the delete or purge actions.
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Item and item revision relations
There are typically many pieces of information that describe or are related to

an item or item revision. Teamcenter uses relations to define the correlation
between data objects and items or item revisions. These include:

¢ Automatically defined relation types

e Special relation types
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Automatically defined relation types
Many item or item revision relations are automatically defined when you
create or add certain objects to an item or item revision structure. For
example, when you add a new item revision to an existing item, the new item

revision is automatically defined as a revision relation. The automatically
defined relation types include:

e Revision
e Jtem master and item revision master
e BOM view and BOM view revision

e Alternate ID
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Special relation types

In addition to the automatically defined relation types, the following relation
types relate objects to items and item revisions:

® Specification relations
¢ Requirement relations
e Manifestation relations
e Reference relations

These relation types are used throughout Teamcenter to aide in workflow
and business rules.

These relationships are typically defined when you paste an object reference
into an item or item revision using the Edit®Paste or Edit®Paste... menu
commands.
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Dataset objects

3-16

When non-Teamcenter applications are launched from Teamcenter, the files
generated are maintained by Teamcenter. The object used to manage these
files is called a dataset.

Datasets are typically stored in item revisions. The symbol preceding the
dataset name may vary depending on the associated application.

Examples of some dataset types:

Symbol type Type File Purpose
B Text Jtxt Text document
|4 MSWord .doc MSWord document
% MSExcel xls MSXExcel spreadsheet
A~ DirectModel |.jt 3D visualization model
- UGMASTER |.prt NX part file

Double-clicking a dataset object launches the associated software application

and loads the file in the application.
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Create a new dataset

1.

Select the folder, item, or item revision under which the new dataset
will reside.

Choose File—New—Dataset... or press Ctrl+D.
The New Dataset dialog box appears.
Note

You can create a new dataset from an existing file by using the
Import option on the New Dataset dialog box.
Type a descriptive name (up to 32 ASCII characters) in the Name box.

This name is used as a label in the object area. It is good practice to
keep the names short so that you can see the entire name in the My
Teamcenter tree.

Optionally, type a description (up to 240 ASCII characters) that will help
to identify this dataset in the Description box.

Select a dataset type from the Type bar by clicking the button in the
display. If the type names are truncated, click the arrow located in the
upper-left corner of the icon display and then select a type from the list.

The Type bar displays the dataset types that you use the most. If you do
not see the type you are looking for, click More... to display all defined
dataset types.

Note

The dataset types displayed in this dialog box are controlled by your
administrator. Therefore, you may be unable to create dataset types
that are visible to you in your workspace.

Select the Tool Used: option to edit the dataset file if more than one
option is available.

To create the dataset from an existing file, click Import - .

The system displays the Import File dialog box.

Navigate to the file to be imported, select the file, and click Import.

The system closes the Import File dialog box, and the path to the file
appears in the Import box.
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Note
The type of file that you import must match the dataset type
selected in step 5.

9. Select Open on Create to launch the tool associated with the dataset and
immediately open the file upon creation.
10. Complete the procedure:
e To close the dialog box without saving the information you entered,
click Cancel.
e (lick OK or Apply to save the information in the database.

The system displays the Paste dialog box. Clicking the Stop button
ends the dataset creation process.

The system displays the new dataset object in your My Teamcenter
tree. If you selected the Open on Create option, the tool associated
with the dataset is launched and the file is opened.
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Dataset versions

Whereas changes to items are captured in item revision sequences, changes

to datasets are captured in versions. In Teamcenter dataset versions can be:
e Used to track changes and undo changes to a dataset by reverting to a

previous version of the dataset.

¢ Used as the basis for creating a duplicate of an existing dataset.
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Key points about dataset versions

e As work progresses and you successively modify a particular dataset,
new versions are added to the database but, version 0 (no value) always
references the latest version of the dataset.

¢ The default version is the latest. In most cases, you should work with this
version unless you have some specific reason to open an earlier version.

e Dataset versions can be used to revert to a previous version of the dataset
and they can also be used as the basis for creating a duplicate of an

existing dataset.

e Normally, you only see the version 0 dataset in My Teamcenter.
Teamcenter hides other dataset versions to reduce clutter.
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Revert to a previous dataset version

Revert to a previous dataset version to track changes and undo changes to a
dataset.

To revert to a previous version of a dataset, select the dataset and choose
File® Open With....

Using the Open... dialog box, you can specify a particular version of a dataset
and/or a specific software application (tool) to use for the current editing
session.
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Purge dataset versions

Purge versions to explicitly remove old versions of a dataset from the
database.

e Teamcenter manages multiple dataset versions until the version limit
is reached.

When the version limit is exceeded, the earliest version of the dataset
is automatically purged from the database in order to make room for
the new version.

¢ The Edit®Purge command can be used to explicitly remove old versions
of a dataset from the database.

— You can select whether to purge all old versions or specific versions
of a dataset.

— To purge a dataset, you must have read, write, and delete privileges
on the versions of the dataset that you want to purge.

— The Purge command completely and permanently removes old
versions of a dataset from the database.

Note

When a dataset is assigned a release status, all earlier versions are
automatically purged.
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Object references

While it appears that object folders contain other objects (because that is
what you see) the folders actually contain references to the objects.

The distinction is subtle but very important. Several folders can contain
references to the same object, however, that object is only stored once in the
Teamcenter database.

Therefore, these folders provide references to the same product information
and allow product information to be shared throughout your enterprise
without having to make multiple physical copies of the data.

F"7 Joan’s Folder
- . ECN CO1 [~ Boris’s Folder

ECH CI1
- ﬁ' Orientation .

@ 911274 Data - Research Request

. ECH Ci1
Researcn Request

@ 911274 Data

E;I Orientation

[~ Templates

Teamcenter Database
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Creating object references

To create an object reference, you can select the desired object and use the
Cut, Copy, and Paste buttons.

The Append option can be used to retain the existing objects in the clipboard
while adding to the clipboard contents using the cut and copy commands.
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Using cut, copy, paste, and append commands

Key points about the cut, copy, paste, and append commands:

These are clipboard commands, which means that they place information
on the clipboard (via cut or copy) and paste it to another location.

These commands affect only the references to objects stored in the
database; they do not cut, copy and paste actual objects.

Cut takes the object’s reference out of the folder and puts it on the
clipboard. It does not delete an object from the database.

Any existing objects in the clipboard are overwritten by the cut objects.
Note
To actually delete an object from the database, use the Delete
command.

Copy puts a new reference to the object on the clipboard; the original

reference to the object remains in the folder.
Any existing objects in the clipboard are overwritten by the copied objects.
Toggle the Append option to add the selected objects to the clipboard
contents.
The existing objects in the clipboard are retained.

Note

The Append option is located on the clipboard menu. The clipboard
menu can be accessed by right-clicking the Clipboard button when
the clipboard contains one or more objects.

v M Append

Clear Clipboard
&7 Send clipboard contents ko WX

The menu is not available when the clipboard is empty.
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e Paste places a reference to the object or objects that are in the clipboard
into the selected folders. The object reference is not removed from the
clipboard, so you can perform multiple paste operations.

Tip
To highlight multiple objects, you can hold down the Shift key to select

objects in a range or the Ctrl key to select objects in a discontinuous
range.
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Dataset named references

Datasets are often used to manage several different types of files. These files
are the named references of the dataset. Datasets are the only data objects
that use named references.

Access the Named References dialog box to view or modify the named
references (files) for a dataset.

1. Select the dataset in the tree or Details table.

2. Choose View®Named References.

The Named References dialog box appears, listing all the named
references of the selected dataset.

3. Optionally, you can cut, copy, paste, import, and export named reference
files, or edit the name of the reference file.

Note

Using the Open button in the Named References dialog box is not
recommended for opening dataset part files.
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Creating new data from existing data

Use the File®Save As command to create new items and datasets based
on existing data.

Create a new item based on an existing item or item revision.

e When the new item is created based on an existing item, related objects
are copied to the new item as references.

e When the new item is created based on an existing item revision, related

objects can be copied to the new item as references, new objects, or not
at all.

Create a new dataset based on an existing dataset.

e When a new dataset is created based on an existing dataset, you can
specify which version of the selected dataset to use in creating the new
dataset. The latest version is used by default.
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Activities

Complete the following activities to reinforce the material taught in this
lesson.
1. Create an item and add master data.
2. Create a new dataset.
In this activity, create a text dataset to document specifications for an
item.
3. Import a dataset.
In this activity, create a dataset using import and modify the relation type.
4. Modify a dataset and work with versions.
5. Create a new item revision.
In this activity, create a new item revision using the Revise command.
6. Create a new item based on existing data.

In this activity, create a new document item based on an existing
document revision.

Review questions

1.

What objects are included in the item structure, by default?

Select all that apply.

¢ Jtem master form

e Jtem revision

e Dataset

¢ Item revision master form

What is an item?

Select all that apply.

e A fundamental data object used to manage information in Teamcenter.
e A package which contains all data related to the item.
e C(Collects data that is applicable to a single revision of the item.

e Generically describes all types of objects that exist in the system.
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3. Only one sequence can be active at any given time for an item revision.

e True
e False

4. Which are special relation types?

Select all that apply.

e Alternate ID

e BOM view and BOM view revision
e Manifestation relations

e Specification relations

5. What Teamcenter object is used to manage non-Teamcenter files?

Select one answer.

e Dataset
e Form
e Jtem

e Revision

6. What do folder objects contain?

Select one answer.

e Jtems
e Named References
¢ References to other objects

e Revisions

3-30 Introduction to Teamcenter MT25100-S-0701



Working in Teamcenter

Summary

Topics learned in this lesson:

¢ Identify items and the item structure.

¢ (Create an item and populate it with master data.
e Use checkout to create an item revision sequence.
¢ Identify datasets and dataset types.

¢ (Create a dataset and work with versions.

¢ C(Create an object reference.

¢ (Create new data from existing data.
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Lesson

Find and view Teamcenter data

Purpose

The purpose of this lesson is to use various methods to locate and view
Teamcenter data.

Objectives

After you complete this lesson, you will be able to:

Perform queries and view search results.

View objects and their properties.

Perform where-referenced and where-used searches.
Use favorites for easy access to your data.

Print information about your data.

Help topics

Additional information for this lesson can be found in:

Getting Started with Teamcenter 2007

My Teamcenter Guide
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Searching the database

4-2

Teamcenter provides tools that enable you to use saved queries (both standard
queries and custom queries defined by your Teamcenter administrator) to
search for your work in the Teamcenter database or in databases that are
part of a Multi-Site Collaboration network.

The Quick Search feature in the navigation pane enables you to search for
data by specifying the dataset name, item ID, item name, or a keyword.

You can run a form-based search by selecting the Advanced option from the
quick search feature or by clicking the Search button on the toolbar.

You can save the results of a search and add them to your My Saved Searches
list. Once saved to the list, you can display the results and refresh the search
to update the display with the latest results.

Note
Quick search results cannot be saved to your saved searches list.
Search History lists the most recently run queries. By default, the last eight

queries are listed, but you or the administrator can change the number
of queries shown.

Introduction to Teamcenter MT25100-S-0701



Find and view Teamcenter data

Perform a quick search

1. Locate the quick search input field, execute button, and menu
' B~ at the top of the navigation pane.

2. Click the menu icon ¥ and select a search type.
3. Enter the appropriate criteria for your search.

4. Click Execute this query & to start the search.

The system displays Quick Open Results dialog box with a list of objects
that match the specified criteria.

Note

If you do not find the object you seek using the quick search, click
Cancel. Choose Advanced from the Quick Search menu or click

Search on the toolbar to display the Search pane, which lets you
use detailed criteria.

5. Double-click an object to open from the list or select an object and click
Open.

The object is retrieved and displayed in the Folders pane.
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Perform an advanced search

1. Click Search on the toolbar or select Advanced from the search menu
at the top of the navigation pane.

The system displays the Search pane with the default search name and
description followed by the search criteria form.

Note
The software ships with Item ID selected as the default search. The

Item ID search form has only the Item ID box for criteria.

2. Enter search criteria.

3. Click the execute button & to perform the search.
Results are displayed in the Folders navigation pane and the data pane.
Note

The Abort button % in the upper left corner of the Teamcenter
window is active while a query is running, but it cannot stop the
database query process once it starts.

4-4 Introduction to Teamcenter MT25100-S-0701



Find and view Teamcenter data

Search results display

The search results are displayed in a search results window.

¢ The name on the search results window matches the name of the search
form.

e Ifmultiple queries are run using the same search form, a number is added
to the name for the search results window so that you can differentiate
between search results. Because multiple search windows can be open
simultaneously, you may want to rename them to make your workspace
easier to use.

EX Item ID (2)

5] Folders x| |21 Search Result E]
EiltemIDi1~3/3) || Name

H-0 ) 93540_15-Bumper 93540_15 -~y Bumper

93540_00 .~ Bumper
93540 -~y Bumper

-t 93540_00-Bumper
#-L 4 93540-Bumper
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Renaming search results

If you plan to keep a search open in your My Teamcenter window for an
extended period of time, or if you have multiple queries open, renaming the
search results is a convenient way to make your My Teamcenter window
more manageable.
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Rename search results

1.

Right-click the search pane label that you want to rename.

The system displays Explorer Popup Menu.

Choose Rename.

The Rename dialog box displays the current name of the search in the
banner.

Type a new name for the search results in the text box.

Click OK.

The name on the search tab is changed to reflect the new name.
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Search pane buttons

Search pane buttons let you change, rerun, clear, and save a search.

Search e _x

Bl ol o+ Took
ltem ID

Find Itemi(s) by ID

Item ID: | |

Use the Tools menu to access additional search functions.

L: ck. 'E-E:En'n: h

| Wiesw Search Criteria Definition, ..
Extended Multi-application Search...

Opkions...

Click the Execute button B to perform the defined search.
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Change your search

1. Click Change in the Search pane to display the Change Search dialog
box.

2. Select a new search from the System Defined Searches, Search History,
or My Saved Searches tabs.

3. Click Change Search to load the selected search criteria into the Search
pane.

Note

When you change the search, the content of the currently displayed
search pane is overwritten to display the form associated with the new
search.

For example, if you are defining criteria for an item revision search and
you want to use data from an item query as criteria for your search, you
can click the item query tab to copy the data and the item revision
search fields are overwritten with the data in the item query.

To prevent your original query data from being overwritten, you can
choose Tools—Lock Search at the top of the search pane.
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Save searches

You can save searches to the My Saved Searches folder, or you can create a
hierarchy of subfolders in which to save searches.

Note

If the Search pane is not open, you can access your saved searches
from the My Saved Searches expand button » under Quick Links in

the navigation pane.
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Save search results to your My Saved Searches folder

1.

2.

Display the search pane with the search results you want to save.

Click Save ‘= at the top of the Search pane.
The system displays the Add Search to My Saved Searches dialog box.

Type a unique name in the Name box, and then click OK.
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Save search results to subfolder of My Saved Searches

1. Display the search pane with the search results you want to save.

2. Click Save = at the top of the Search pane.

The system displays the Add Search to My Saved Searches dialog box,
letting you perform either of the following actions:

¢ In the Created In box, accept the indicated folder or select an existing
folder from the list =] .

e (Click More Folders..., then New Folder... and provide a new folder
name in the New Saved Search Folder dialog box.

3. Click OK.

The system stores the search in the selected folder. The search appears in
the My Saved Searches list.
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My Saved Searches

Searches saved from the Search pane are listed in the My Saved Searches
menu in the Quick Links section on the navigation pane.
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Perform a saved search

1. Click the Search button “* on the My Teamcenter toolbar.

2. Expand the My Saved Searches menu ” in the Quick Links section on
the navigation pane.

3. Choose a saved search.

The system displays the criteria in the Seach pane and the results in
the Folders and Data panes.
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Customize saved searches

1. Click the My Saved Searches text in the Quick Links section on the
navigation pane.

The system displays the Customize My Saved Searches dialog box.
2. Select a saved search.

3. Use the buttons to delete X , rename & , or reorder ~ ¥ the saved
searches.

4. Click Apply to accept your changes; OK to accept your changes and close
the dialog box, or Cancel to discard changes and close the dialog box.
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Working with searches
Search results are displayed in panes in the My Teamcenter window.

e Each time you execute a search, a new pane is created.

¢ You can right-click the pane label to display the Explorer Popup Menu to
work with the objects found by the searches and to compare the results of
one search to another or to the contents of your other lists.
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Compare search results

You can also compare the results of one search to those of another search.

1.

2.

Display the search that you want to compare.
Right-click the search pane label to display the Explorer Popup Menu.

Choose Compare To from the menu.

A submenu displays all open components to which the selected component
can be compared.

Select a component from the Compare To submenu.

The Compare Report dialog box displays the contents of the selected
components. Differences between the selected components are highlighted
in green, identical objects have a transparent background, and the object
currently selected is highlighted in purple.

B x|
153

E-Ttem... (2) E-Ttem... (1)

-7, BE20°R side ASM -2, BE11-Pirien

- * 3621-R-Pinion +- - 3610-L side A5M

% &3
i The views being compared are completely different.

Difference 1 of 2 E] D Difference 1 of 2 E] D

¢ total different object{s) Found. [] Differences
Close

Optionally, browse the differences using the navigational buttons at the
lower-right corner of each pane. This can be useful when comparing
components containing a large number of objects.

Optionally, select the Differences option to display only the differences
between the components.

Click Close to exit the dialog box.
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Refresh a search

=

You can refresh queries to update results by clicking the Rerun button <! at
the top of the Search pane.
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Close search results

Search results that have not been saved to a folder are lost when you close
the pane.

1. Right-click the search pane label to display Explorer Popup Menu.
2. Choose Close to close the current search or choose Close All to close all
open searches.
Note

The Close All option closes all open components, including your
Home folder. To restore the Home folder, click Home % .
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Print search results

You can print a snapshot of the search results tree.
1. Right-click the search pane label for the search that you want to print.
The Explorer Popup Menu appears.

2. Choose Print.
The Print dialog box appears.

3. Optionally, modify the print options and properties.

4. Click OK.

The search results displayed in the tree are printed. If the tree displays
all of the results, all results are printed. If the tree only displays one page
of results, only that page is printed.
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View and modify object properties

The properties associated with your data objects can be viewed in the Details
pane, Summary pane, or in the Properties dialog box.

You can modify object properties, such as name, description, and unit of
measure, using the Summary pane or the Properties dialog box.
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4-22

View properties in the Details pane

To view properties in the Details pane:

1. In the tree pane, select the object or objects that you want to view.

2. Choose Details as the display pane.

0 Summary

& Details

oo Wigwer

¥ Referencers

U Summary  *

The system displays the properties of the

pane.

Introduction to Teamcenter

%, 3700-Rear ASM

selected objects in the Details

E] %]‘ Details *
Date Modfied | _..|

Object Type Relation Ow,., | Gro.,

% 3700/A-Rear ASM CCC_Item Re... |Revisions  |Andr... |Body 15-May-2007 .., |~
@ 3700 CCC_Tkem Ma... |Item Mast... |Andr... |Body 15-May-2007 ...
D-[‘; 3700-assembly assembly BO,.,  |BOM Views |Andr... |Body 15-May-2007 ...
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View properties in the Summary pane

To view properties in the Summary pane:

1. In the tree pane, select the object or objects that you want to view.

2. Choose Summary as the display pane.

oo Wigwer ¥

W Summary

Details

e Viewer
* Referencers

B Display Data

The system displays the properties of the selected objects in the Summary

pane.
. 3760/A;1-Main gear » aummary
Object: |

Marne: e
w

ID: | |

Revision: | |
Description: -~
w

Item: | =, 3760-Main gear ™
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View properties in the Properties dialog box

To view and modify object properties in the Properties dialog box:

1. In the tree pane or Details tab, select the object that you want to view.

2. Choose View®Properties or right-click the object and choose Properties.

The system displays the properties of the selected object in the Properties
dialog box.

P Properties

C_Item Re

I}EE

Object: | |

Marne: M

I | |

Revision: | |

Description: M —

Item: (%, 3760-Main gear ¥
¢ I *

[
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Modify object properties

The properties that can be modified vary from object to object, and you must
have write access to make modifications.

Note

If any revision of an item has been released, the unit of measure cannot
be modified.

Note

You cannot change ownership of the selected object using this method.
Instead, use the Edit®Change Ownership menu command.

1. Select the object in the tree pane or the Details pane.

2. Choose Summary as the display pane, or right-click the object and choose
Properties.

3. Click the Checkout and Edit button.

4. Modify the property values, as required.

5. Click Save, Check In, or Cancel Check Out.

Use the Save button to save the change and keep the object checked
out for further modification.

Use the Check In button to save the change and check the object back
into the database.

Use the Cancel Check Out button to revert any changes and cancel
the checkout.
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Customizing the Details pane data display

You can customize the display of information in the Details pane to best suit
your needs. You can:

¢ Reposition columns.
¢ Insert columns.
e Apply sorting criteria.

e Remove columns.
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Reposition columns

1. Click the header of the column that you want to move and hold the mouse
button.

2. Drag the column to the desired position in the table and release the
mouse button.

Note

Leaving the Object and Type columns in the first and second
positions in the table allows you to easily identify the data displayed
in the table.

The column is displayed in the new position.
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Insert columns

1. Right-click a column header in the Details view and choose Insert
Columns.
The Change Columns dialog box appears.
2. In the Category and Type box, expand the category list and select the
type of object for which you want to display a property.
3. Select attributes from the Available Columns list and click the Add
button.
Note
Display only the properties that you view or change frequently. The
more properties that are displayed, the longer it takes to expand
folders and items.
4. Set the display order of the columns using the Up and Down arrow
buttons.
5. (Optional) Clear the Use displayable name box to display the attribute
names rather than the displayable names in the column headers.
6. Click Apply to insert the columns into the current view.
7. Click Cancel to close the Change Columns dialog box.
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Apply sorting criteria
1. Right-click one of the column headings and choose Sort.

2. In the Sort dialog box, select the primary property to be sorted on from
the list in the Sort By area, and select whether to display the property
values in ascending or descending order.

3. (Optional) Select a property in the Then By section of the dialog box and
select whether to display the property values in ascending or descending
order.

Note

You can use up to three properties as sort criteria.
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Remove columns

1. Right-click the header of the column that you want to remove and choose

Remove this column.

2. Click Yes to remove the column.
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Using favorites to organize your data

If you have data that you access frequently, for example, parts, forms, or
processes, you can track them by adding links to your Favorites list in the

navigation pane.

Note

To display the data, click the link in the Favorites list. The file is opened
in the application associated with the data type. For example, clicking a
link to a Word document opens the file in Microsoft Word. Clicking a
link to an item revision opens the item revision in My Teamcenter.
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Add a link to your Favorites list

1. Right-click the object you want to add to your Favorites list.
2. Choose Add to Favorites.

3. In the Organize Favorites dialog box, click the Add to favorites button

- 1
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Add a subfolder to your Favorites list

1. Click the Organize link in Favorites section.

2. In the Organize Favorites dialog box, click the Create New Folder button
A

1«&7,

3. Type a name for the new folder and click OK.

4. Click Close.
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Remove a link or folder from the Favorites list

1. Click the Organize link in Favorites section.
2. In the Organize Favorites dialog box, select the link or folder from the list.
3. Click the Delete button X .

Click Close.

-~

Tip
You can rename favorites folders by selecting the folder and clicking the
Rename button L .
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Where-referenced and where-used searches

In addition to locating your data, you can also perform where-used searches
and where-referenced searches. These searches are available in the
Referencers pane.

e Where-referenced searches determine where a part or component is
referenced within the Teamcenter database. The database objects that
include a reference to the item or item revision are found.

e Where-used searches enable you to identify all assemblies that contain,
or use, a particular item or item revision. All assemblies that contain, or
use, an item or item revision are found.

Using these searches, you can determine the effect that modifying an item or
item revision have on assemblies and database objects. You can assess the
impact of engineering changes to the product structure and determine if
changes in one assembly affect other assemblies.
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Perform a where-referenced search

—

Select the Referencers pane from the menu in the upper right of the My
Teamcenter window.

Select an object in the data pane tree.

Select Referenced from the Where option list, located in the upper-left
of the pane.

Select a depth level from the Depth list in the bottom-right corner of the
window:

One Reports only immediate parent components of the object.
Level

All Reports all parent components of the object, up to the top-level
Levels directory.

Top Reports only the top-level component.
Level

The object and the objects by which it is referenced are displayed in
graphical format. The results can be used as the basis for another
where-used or where-referenced search, or they can be formatted and
printed.

Double-click the object in the Referencers pane to start the search.

The object and the objects by which it is referenced are displayed in
graphical format. The results can be used as the basis for another
where-used or where-referenced search or they can be formatted and
printed.
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Perform a graphical where-used search

—

Select the Referencers tab.
Select an item or item revision in the tree.

Select Used from the Where option list, located in the upper-left of the
pane.

Select a rule from the Rule list.

This rule provides parameters to locate the assemblies in which the item
or item revision is used. Revision rules are made up of sequential lists
of entries, each of which is evaluated to obtain a configured revision of
the item. For example, if you select the Latest Working rule, only the
latest working revision of the assembly is retrieved. Released assemblies
and earlier versions of the assembly are not retrieved when this rule

is selected.

Select one of the following depth levels from the Depth list located in the
bottom-right corner of the window:

One Reports only immediate parent components of the object.
Level

All Reports all parent components of the object, up to the top-level
Levels directory.

Top Reports only the top-level component.
Level

Double-click the item or item revision in the Referencers pane to start
the search.

If the item or item revision is not part of an assembly that matches the
selected revision rule, Teamcenter displays a message to that effect. If
the item or item revision is part of a configured assembly, the structure is
displayed in graphical format in the Referencers pane. The results can
be used as a basis for another where used or where referenced search or
they can be formatted and printed.
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Printing information about your data

Use the Print and Print... commands on the File menu to display, format, save,
and/or print the following types of information about your Teamcenter objects:

¢ The hierarchical structure of a selected object and its descendant objects.

For example, you can select a folder and display all of the first-level
descendants or you can enter a level of descendants to be displayed. This
allows you to display and print any level of the structure.

e The hierarchical structure of a selected object (first-level descendant
objects only), including the object properties and corresponding values.

e The properties of a selected object and their corresponding values.

¢ The active Teamcenter table or the Referencers pane, as it appears in the
application window.

Note

You can only print information related to a single selected object.
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Print object properties

Use the File®Print command to report object properties.
1. Select the object and choose File ®Print.
The Print dialog box appears.

59 Print... 3600/A-Front ASM 53

(%) Object Properties

() Contents

() Application (HTML| Text)
() Application {Graphics)

Object Properties is selected, by default.

2. Click OK.
The system displays the object properties report for the selected object.

If you specify a level greater than 1, the system displays the object report
showing the specified level of descendant objects.

3. Select the output type, HTML or Text.

4. Depending on the output you choose, you can select the applicable icon to
print to a web browser or printer, or save the report to a file.

5. Click Close to close the Print dialog box.
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Print the active Referencers pane

The application options on the Print dialog box enable you to print the active
table, tree display, or Referencers pane as it appears in your Teamcenter

window.
1. Click in the Referencers pane to activate the window.
2. Choose File®Print.
3. Choose either of the application options, Application (HTML/Text) or
Application (Graphics), depending on the desired output display.
4. Choose OK.
The Where Reference report appears showing the contents of the active
Referencers pane.
Note
The report title is Where Reference irrespective of whether the pane
shows the results of a where used or a where referenced search.
5. Select the output type and media.
6. Click Close to close the Print window.
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Generating reports

Use Tools®Reports to access the report options and launch the report
generation wizard.

]
4 |: "] Report Designer Reports
Trace Repaort 4l 2 surmary Reports
Check Index Status...

:l' Cusktom Reports

The report generation wizard in My Teamcenter guides you through the steps
required to generate a report:

e Select a design format.

e Specify the information you want to extract from the database.

e Choose an output format.

Some reports are available as part of the standard Teamcenter installation.

In addition to the standard report designs, Teamcenter administrators can
create custom reports.
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Activities

4-42

Complete the following activities to reinforce the material taught in this
lesson.
1. Perform quick and advanced searches.
2. Rename and save a search.
3. Customize the Details pane data display.
4. Add items to a favorites folder.
In this activity, create a favorites folder and add items to it.
5. Perform where-used and where referenced searches.
6. Print information about your data.

In this activity, print object contents.

Review questions

1.

Why is a number added to the name for the search results window?

Select all that apply.

e Because multiple search windows can be open simultaneously.
e So that you can differentiate between search results.

e So the name on the search results window matches the name of the
search form.

In which areas can you modify properties?

Select all that apply.

¢ Details pane
¢ Properties dialog box
¢ Summary pane

e Viewer pane
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3.

4.

5.

6.

What can you track in your Favorites list?

Select one answer.

e Data

e  Worklist

e Saved searches
e  Web sites

Where-referenced searches are used to:

Select one answer.

¢ Find objects in the Teamcenter database that contain a reference to
the selected part or component.

¢ Find all assemblies that contain, or use, the selected item or item
revision.

e List the child parts of the assembly.
e Show the saved queries that find the part.

Where-used searches are used to:

Choose one answer.

¢ Find objects in the Teamcenter database that contain a reference to
the selected part or component.

¢ Find all assemblies that contain, or use, the selected item or item
revision.

e List the child parts of the assembly.
e Show the saved queries that find the part.

The report generation wizard in My Teamcenter guides you through the
steps required to generate a report.

e True

e TFalse
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Summary

4-44

Topics learned in this lesson:

1.

2.

3.

4.

Items and item types.

Item and item revision relationships.
Search the database.

View object properties.

Create favorites.

Perform where-used and where-referenced searches.

Print information about your data.

Introduction to Teamcenter
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Protect and access data

Purpose

The purpose of this lesson is to learn how data is secured and access is
controlled when working in a collaborative product data management

environment.

Objectives

After you complete this lesson, you should be able to:

e Identify your group and role.
e Check in and check out data.

e View data access settings.

Help topics

Additional information for this lesson can be found in:

e  @Getting Started with Teamcenter 2007

e My Teamcenter Guide

Introduction to Teamcenter
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User groups and roles

Your account has been set up by your system administrator. The account
includes the following:

¢ Person Name

Your actual name and e-mail address.

e UserID

Your Teamcenter account name.

Your system administrator has also set up the necessary groups in the
software.

e A user may be in multiple groups.
® One group is designated as your default group.

¢ Inside a group, you (as a user) can perform multiple roles.
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The user name, group, and role for the logged-on user appears in the My
Teamcenter window, as shown in the following example:

[ Hope, Roberta (rhope) - body Design Engineer

Wayne, Joan Jwayne)
Group =haseline
Role =Instructor {defaulty

Group =training
Role =Autor
Role =Consumer

In this example, the person name is Joan Wayne. The user name for this
person is jwayne.

Joan is in two groups, baseline and training.

¢ Inside the baseline group, Joan performs the role Instructor.

¢ Inside the training group, Joan performs the roles Author and
Consumer.
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Why have user groups and roles?

There are several reasons why using different groups and roles is beneficial:

e Manage data access privileges (read, write, and delete) per group and role.

¢ Define and control review/approve processes based on group and role.

¢ Organize data according to which group created it.
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Change your group and role setting

Typically you work in your default group and role and the data you create is
owned by that group. During a logon session, you may need to change your
group or role, so you can find and access data owned by another group.

1. Choose Edit®User Setting.
The User Settings dialog box appears.

5P User Settings - rhope E]

5 Hope, Roberta
IR || Session settings
. (aroup:
+ Session P: pody
£ Login Rale: Design Engineer
3 valume: skd wol

Application Logging

[ ] Journalling

£

Ik

] [ Apply ] ’ Cancel

2. If necessary, click Session.

3. Select the desired group and role setting from the respective menus.

Note

Only the groups of which you are a member and your possible roles
are available for selection.

4. Click OK.
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Set your default group and role

You can set the group and role you typically work in as the default setting.
This is used by the system at logon.

1. Choose Edit®User Setting.

2. Click Logon.

The Logon settings dialog box appears.

AP User Settings - rhope E]

ot Hope, Roberta
—__ I Login settings
Y Session Default Group: | b, " ~
" Login Default Yolurme: &
&
- Default Role: Group Fole

body -

drivetrain

M,
< | >
Ik ] [ apply ] l Cancel

3. Set your default group and role.

In the Default Group box, select the default group for logon.
Note

Only the groups of which you are a member are available for
selection.

In the Default Role section of the dialog box, select the default role for
the group.

Note

If desired, you can select a default role for each of the groups
you are a member.

4. Click OK.
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Note

You can also change your logon password from the Login settings
dialog box by clicking the Change Password button.
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Data checkin and checkout

The integrity of your data is protected by the managed checkin/checkout
features that allow you to lock out other users from work that is in process,
allowing them to view, but not modify, the information.

¢ The checkout feature locks an object in the database so that only you
can modify it.

¢ The checkin feature releases the lock, allowing other users to access the
object.

e The Check-Out and Check-In commands are available on the Tools menu
and as buttons on the Summary pane and Properties dialog box.

— Use the Tools menu options to reserve the object for modification.

— Use the buttons on the Summary pane and the Properties dialog box
when you modify object properties.

¢ Only your administrator can circumvent the security that the checkout
function provides.

The following objects can be checked into and out of the database:
e Folders

e Jtems and item revisions
e Datasets
e Forms

e BOM views and BOM view revisions
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Explicit checkout
When you use the Check-In/Out commands on the Tools menu to check out an

object, you explicitly check the object out of the database. Explicit checkout
ensures exclusive modification access to an object.

To explicitly check out an object, the following conditions must be met:

¢ The object must not be checked out by another user.
¢ You must have write access to the object.

e The object cannot be archived.
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Implicit checkout

Teamcenter automatically creates an implicit checkout to ensure that two
processes are not allowed to simultaneously update a dataset. Implicit
checkout differs from explicit checkout in the following ways:

e Implicit checkout is automatic and occurs when you open a dataset
for modification. When the modifications are completed, the dataset is
automatically checked back in to the database.

¢ You cannot initiate an implicit checkout operation.

e Implicit checkout actions are not logged in a history file.

e Users included on notification lists are not notified when implicit checkout
takes place.
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Check an object out of the database

1.

Select objects in the My Teamcenter tree or a BOM line in Product
Structure Editor.

Choose Tools—Check-In/Out—Check-Out....
The system displays the Reserve dialog box.

If you want to check out only those objects displayed in the dialog box (no
attachments or component objects), go to step 5.

Optionally, check out component objects or attachments along with the
selected objects.

Click Yes (on the Reserve dialog box) to check out the selected objects.
Note

+ . . . .
The . symbol in the right margin of the dialog box (opposite
the object) indicates that the check-out process was successfully

completed. If an error occurs during the process, the error e
symbol is displayed for that object. You can double-click the button
to display details about the error.
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Check an object in to the database

1. Select one or more objects that are currently checked out or select a
checked-out BOM line in PSE.

The Check-In option unlocks objects in the database, including assemblies
in PSE, that have been previously checked out.

2. Choose Tools—Check-In/Out—Check-In....
The system displays the Unreserve dialog box.

3. If you want to check in only those objects displayed in the dialog box (no
attachments or component objects), go to step 5.

4. Optionally, check in component objects or attachments along with the
selected objects.

5. Click Yes (on the Unreserve dialog box) to check in the selected objects.
Note

The | symbol in the right margin of the dialog box (opposite
the object) indicates that the check-in process was successfully

completed. If an error occurs during the process, the error e
symbol is displayed for that object. You can double-click the button
to display details about the error.
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Transfer checkout to another user

1. Select an object that has been checked out of the database.

2. Choose Tools—Check-In/Out—Transfer Check-Out.
The system displays the Transfer Check Out dialog box.

3. Click LOV = to search for a user.
The system displays the LOV dialog box.

4. Select a user name from the list, and click OK.

The system closes the dialog box, and the user is designated as the New
User to whom checkout will be transferred.

5. Click Yes to transfer checkout.
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Canceling a checkout request

You can select a dataset that is checked out and right-click to choose the
Cancel Check-Out command.

The system displays the Cancel Check-Out confirmation dialog box.
* C(lick Yes to cancel the checkout.

e (lick No to stop the cancellation operation.
Note

The Cancel Check-Out command cancels only explicit dataset checkout.

If the dataset has not been modified, the checkout is canceled immediately.

If the dataset has been modified, a Cancel Check-Out information box

appears showing the following message: Modifications made to the
dataset may be lost.
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View the checkout history of an object

1.

Select the object in the tree and choose Tools—Check-In/Out—Check-Out
History.

The system displays the Check-Out History dialog box containing the
following information:

e Date and time of each checkout transaction
e Name of the user who performed the checkout

e Site name and user ID of remote users who have checked the object
out of the database

e Status of each transaction: checkin, checkout, transfer checkout, or
cancel checkout

e Change ID and comments

Note

You can also determine to which user an object is currently checked
out by right-clicking the object and choosing Properties, then
clicking the Reservation link.

Click Close to exit the Check-Out History dialog box.
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Data access and ownership

Managing object protection and ownership is crucial in a
distributed-computing environment. Because workspace objects represent
actual product information in the database, they must be protected from
unauthorized access, modification, and deletion.

Rules-based protection

Rules-based protection is configured by your administrator and includes
conditions or rules that control access to objects. These rules affect your
entire Teamcenter site and are enforced by the Access Manager (AM).

Object-based protection

Object-based protection uses access control lists (ACL) to create exceptions
to rules-based protection on an object-by-object basis. Object ACLs are most
useful for either granting wider access or limiting access to a specific object.
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View access privileges based on your group and role

1. Select an object in the tree or Details table.

2. Click the Access button @ on the toolbar.
The system displays the Access dialog box, showing the privileges for the
user and group under which you are logged on.

3. To view privileges assigned to your other roles and groups, select the
role or group from the list.
The system updates the Access table to reflect the privileges of the
selected group or role.

4. Click the Display extra protection button to display additional

information about the privileges.

The system displays the Extra Protection dialog box listing the privileges,
along with the verdict (grant or deny), named ACL, accessor, and rule
path information.
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View access privileges assigned to an object

1. Select an object in the tree and click the Access button 4 on the toolbar
or right-click the object and choose Access.

2. Click the Access button @ to display the ACL Control List box.

3. When you finish viewing the ACLs, click Close.
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Activities

Complete the following activities to reinforce the material taught in this
lesson.

1.

3.

4.

Change your group setting.

In this activity, change your group setting and observe the current setting
display.

Use implicit and explicit checkout.

In this activity, use implicit and explicit checkout to manage access to
your data.

View checkout history of an object.

View access privileges for an object.

Review questions

1.

3.

What is the purpose for using different groups and roles?

Select all that apply.

¢ Define and control the review/approve processes.
e Manage data access privileges.
¢ Organize data.

e All of the above.

After you log in, you cannot change your user group and role settings.

e True
e False

You can set the group and role you typically work in as the default setting.

e True

e False
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4. What action can other users take on an item checked out by another user?

Select all that apply.

¢ Modify the item properties.
¢ (Check out the item.

¢ View the item.

e None of the above.

5. What user action initiates an implicit checkout?

Select one answer.

¢ Log out of Teamcenter.
¢ Open a dataset for modification and an automatic check out occurs.

e Use the Check-In/Out commands on the Tools menu to check out an
object.

e View item properties.

6. What are the two types of data protection?
Select all that apply.

¢ Group-based protection
e Item-based protection
¢ Object-based protection

¢ Rules-based protection
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Summary

Topics learned in this lesson:

1. Data access based on group and role.
2. Protecting data using check in and check out.

3. Viewing data access settings.
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6 Course Summary

Course objectives

The overall objective of this course was to become familiar with the rich client
user interface and learn the basics of using the Teamcenter software.

¢ To understand the concept of collaborative product data management
(cPDM).

¢ To become familiar with the rich client and thin client user interfaces.
e To use the rich client user interface to perform basic user tasks.

e To use various navigation methods to locate, view, and report on product
data.

e To create Teamcenter items and populate the items with master data.

e To learn how data is secured and access is controlled in a collaborative
data management environment.
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A Classroom system information

Using Teamcenter class data sheet

Values in this table should be blank and are provided for students to

document their classroom setup. Optionally, instructors may hand out a

preprinted data sheet.

Data Item

Data Value

Domain

OS user ID
OS password

Local Computer

Teamcenter user ID

Teamcenter password

Virtual Image

Host name

Virtual Image

Root directory

Virtual Image

Volume directory

Virtual Image

Rich client

Virtual Image

Thin client

Virtual Image

Templates directory

Virtual Image
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B Course agenda

Introduction to Teamcenter course agenda

Daily schedule based on 9:00 a.m. to 5:00 p.m. schedule.

Day 1 Morning
Introduction
Course overview
Lesson 1 Introduction to Teamcenter
Lesson 2 Getting Started with Teamcenter
Lesson 3 Working in Teamcenter
Afternoon
Lesson 4 Find and view Teamcenter data
Lesson 5 Data access and protection
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C

Student profile

Teamcenter student profile

Name Date

Employer

U.S. citizen? Yes / No

When is your planned departure time? am/pm

Please answer the following questions as honestly as you can. We strive to
provide training that meets your needs. If you have any additional comments,
please write them on the back of this form.

1.

2.

Job title:

Current responsibilities:

How long have you held these responsibilities? Years

How long have you been working with PDM and CAD/CAM systems?
Years

What other PDM systems are you familiar with?

What other CAD/CAM systems are you familiar with?

Are you currently using Teamcenter? Yes / No Product
Version Hours per week?

Are you currently using NX? Yes / No Version Hours per week?

What are the primary uses of Teamcenter at your site?
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10. What do you model in your NX part files (castings, assemblies, and so on)?

11. List other completed PDM or CAD/CAM courses and the provider
including self-paced/computer-based training:

Course Provider

12. Check the box that best describes your current skill level in the various
Teamcenter and NX disciplines listed in the following table.

None [Novice [Intermediate |Advanced |Future

NX user
Teamcenter
Integrations for
NX

Teamcenter user
Teamcenter
admin
Teamcenter
customizer (BM)

Additional comments:
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Course evaluation

Course Evaluation

You may instead complete this evaluation online at:

http://training.ugs.com/eval
The online evaluation will require you to enter a “session ID” for this class. This should be provided

by your instructor and noted here: Session ID

Course Name Course #
Dates thru
Please share your opinion in all of the following sections with a “check” in the appropriate box:
> & g >
Instructor: | g g 2 E 2 § 2w Za
If there were 2 instructors, please evaluate the 2nd instructor with “X’s” g g g E % E g E g §
52 2 22 2% ¢ g%
Instructor: X
L clearly explained the course objectives.............ccoccorrerrenens BRI SR
2 ...was knowledgeable about the SUDJECE,..............ooooor e
3. ...answered my questions appropriately._. O O O 0 O O
4. ... encouraged questions in Class, . ............ccceevreeeserseessesssnnsenins b o o o o d
5. ...was well spoken and a good communicator g g g O O O
6. ...was well prepared to deliver the course,__................oovee... 0 0 0 O O O
- O O O 0o O O
8. O O 0O O O O
9, g O o o o d
10. o o o o o o
11. o o o o o 0O
12. g 0o o 0O O o
Overall impression of instructor(s) | O O (] Excellent

Suggestions for improvement of course delivery:

What you liked best about the course delivery:

Class Logistics:

1. The training facilities were comfortable, clean, and provided a good learning

MVIFOMIMENE ...\ oooeeeeeeeseeeseeeseeesessseeseseessseneseeessesssessanessseesesesseeessemaseenae o o o o o o
2. The computer equipment Was FelabIE..................cooevvereueeereeseeeseesessesesessesssseseenes o o 0o 0 0O 0O
3. The software performed properly...............cooecorereeeeseeeecsesessssessessssssssssesssssseens o o 0o 0o a d
4. The overhead projection unit was clear and working properly ... ... o o o o o O
5. The registration and confirmation process was efficient________.......... o o o o o 0O

SEE BACK

Rev-2/1/06-btr
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Course Evaluation

Course Name Course #
Dates thru

Please share your opinion for all of the following sections with a “check™ in the appropriate box:

DISAGREE

OO OOQO DbISAGREE
DISAGREE
AGREE

OO O OO AGREE

AGREE

Material:

OO0OO0OOQO SOMEWHAT
OO OOCO STRONGLY

OO OOQO STRONGLY
OOO0OOQO SOMEWHAT
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6. How appropriate was the length of the course relative to the material? (] Too short [] Too long [] Just right

Comments on Course and Material:

....................................................... Poor [] O O O O (] Excellent

Overall impression of course

Hotels: (we try to leverage this information to better accommodate our customers)

1. Name of the hotel Best hotel I’ve stayed at... 0 0O 0 0 O O
2. Was this hotel recommended during your registration process? __..............ccccooveerverserscrsersersersersennes [JYES D NO
3. Problem? (brief description)

Student:
1. I met the prerequisites for the class (I had the skills I needed)............................ O O g g (] O
2. My objectives were consistent with the course objectives,.................oooveveveiiiins U o d O O 0Od
3. T will be able to use the skills I have learned on my job,......................... O O O O O O
4. My expectations for this COurse Were Met,...............ccoceeeeeeeesresreeseesessesseesessensens o o o o o0 0O
5. Iam confident that with practice I will become proficient, . ......................... O O O O O O
Student Name (optional): Location/room

O Please “check” this box if you would like your comments featured in our training publications.
p Y gp
O Pilease “check” this box if you would like to receive more information on our other courses and services.
Thank you for your business.

We hope to continue to provide your training and personal development for the future!
Rev-2/1/06-btr
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